Application Note

Anybus® OPC Server

Doc.Id. SCM-7032-028
Rev. 3.01
Important User Information

This document is intended to provide a good understanding of the functionality offered by Anybus OPC Server.

The reader of this document is expected to be familiar with high level software design, and communication systems in general. The use of advanced network specific functionality may require in-depth knowledge in networking internals and/or information from the official network specification. In such cases, the people responsible for the implementation of this product should either obtain the specification to gain sufficient knowledge or limit their implementation in such a way that this is not necessary.

Liability

Every care has been taken in the preparation of this manual. Please inform HMS Industrial Networks AB of any inaccuracies or omissions. The data and illustrations found in this document are not binding. We, HMS Industrial Networks AB, reserve the right to modify our products in line with our policy of continuous product development. The information in this document is subject to change without notice and should not be considered as a commitment by HMS Industrial Networks AB. HMS Industrial Networks AB assumes no responsibility for any errors that may appear in this document.

There are many application of this product. Those responsible for the use of this device must ensure that all the necessary steps have been taken to verify that the application meets all performance and safety requirements including any applicable laws, regulations, codes, and standards.

HMS Industrial Networks AB will under no circumstances assume liability or responsibility for any problems that may arise as a result from the use of undocumented features, timing, or functional side effects found outside the documented scope of this product. The effects caused by any direct or indirect use of such aspects of the product are undefined, and may include compatibility issues and stability issues.

The examples and illustrations in this document are included solely for illustrative purposes. Because of the many variables and requirements associated with any particular implementation, HMS Industrial Networks AB cannot assume responsibility for actual use based on these examples and illustrations.

Intellectual Property Rights

HMS Industrial Networks AB has intellectual property rights relating to technology embodied in the product described in this document. In particular, and without limitations, these intellectual property rights may include patents and pending patent applications in the US and other countries.

Trademark Acknowledgements

Anybus® is a registered trademark of HMS Industrial Networks AB. All other trademarks are the property of their respective holders.
Contents

Introduction 5

Introduction
Overview 5
Applicable Anybus Products 5
Requirements 5
More information about the network and the products 6

Solution overview 7

Solution overview
Example 1 - Anybus PCI-Card 7
Example 2 - Anybus X-gateway 8

Anybus Configuration 9

Anybus Configuration
PROFIBUS Master Configuration 9
  Anybus Communicator Configuration 11
  X-gateway Configuration 14

OPC Server Configuration 17

OPC Server Configuration
OPC Server Setup 17
  Adding tags 22
  Enabling OPC Server Only Access Mode 26

Testing with Built-in Monitor 27
About this Document

The reader of this document is expected to be familiar with industrial communications and Anybus Master PCI units and X-gateways.
For more information, documentation etc., please visit the HMS web site, 'www.anybus.com'.

Document History

Summary of Recent Changes (2.00... 3.01)

<table>
<thead>
<tr>
<th>Change</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Word to InDesign</td>
<td>All</td>
</tr>
<tr>
<td>Changed order of chapters</td>
<td>5-24</td>
</tr>
<tr>
<td>Various updates</td>
<td>All</td>
</tr>
</tbody>
</table>

Revision List

<table>
<thead>
<tr>
<th>Revision</th>
<th>Date</th>
<th>Author(s)</th>
<th>Chapter(s)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.00</td>
<td>2009-04-01</td>
<td>MiM</td>
<td>All</td>
<td>First release</td>
</tr>
<tr>
<td>3.00</td>
<td>2009-11-04</td>
<td>KeL</td>
<td>All</td>
<td>Major rewrite, from Word to InDesign</td>
</tr>
<tr>
<td>3.01</td>
<td>2011-03-18</td>
<td>KaD</td>
<td>Anybus Configuration</td>
<td>Minor corrections</td>
</tr>
</tbody>
</table>

Conventions and Terminology

The following conventions are used throughout this document:

- Numbered lists provide sequential steps
- Bulleted lists provide information, not procedural steps
Support

HMS Sweden (Head Office)
E-mail: support@hms-networks.com
Phone: +46 (0) 35 - 17 29 20
Fax: +46 (0) 35 - 17 29 09
Online: www.anybus.com

HMS North America
E-mail: us-support@hms-networks.com
Phone: +1-312-829-0601
Toll Free: +1-888-8-Anybus
Fax: +1-312-738-5873
Online: www.anybus.com

HMS Germany
E-mail: ge-support@hms-networks.com
Phone: +49-721-96472-0
Fax: +49-721-964-7210
Online: www.anybus.com

HMS Japan
E-mail: jp-support@hms-networks.com
Phone: +81-45-478-5340
Fax: +81-45-476-0315
Online: www.anybus.com

HMS China
E-mail: cn-support@hms-networks.com
Phone: +86 10 8532 3023
Online: www.anybus.com

HMS Italy
E-mail: it-support@hms-networks.com
Phone: +39 039 59662 27
Fax: +39 039 59662 31
Online: www.anybus.com

HMS France
E-mail: mta@hms-networks.com
Phone: +33 (0) 3 89 32 76 41
Fax: +33 (0) 3 89 32 76 31
Online: www.anybus.com
Introduction

Overview

An OPC Server is a software application that acts as an API (Application Programming Interface) or protocol converter. The Anybus OPC Server will connect to for example an Ethernet card (using a HMS Transport Provider for Ethernet), and translate the data into a standard-based OPC format. OPC compliant clients, such as Labview or Scada systems, can connect to the OPC Server and use it to read and write device data. An OPC Server is analogous to the role a printer driver plays to enable a computer to communicate with an ink jet printer. An OPC Server is based on a Server/Client architecture.

Applicable Anybus Products

<table>
<thead>
<tr>
<th>Description</th>
<th>Network Name/Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anybus-PCI</td>
<td>Any network</td>
</tr>
<tr>
<td>Anybus X-gateway</td>
<td>Ethernet Slave to any network</td>
</tr>
</tbody>
</table>

Note: The Anybus OPC Server is supported by all X-gateway variants containing the interfaces ModbusTCP slave/client, EtherNet/IP slave/adapter, or PROFINET slave/device.

Requirements

The following table lists the necessary items for configuring the OPC for the test applications described in this document. A power supply 24 V DC and a PROFIBUS cable are needed in both examples.

<table>
<thead>
<tr>
<th>Description</th>
<th>Name/Type</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>OPC server for Anybus</td>
<td>Software</td>
<td>2.0.1</td>
</tr>
<tr>
<td><strong>PCI example</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Anybus-PCI PROFIBUS Master</td>
<td>AB3502</td>
<td>N/A</td>
</tr>
<tr>
<td>Anybus NetTool for PROFIBUS Master</td>
<td>Software</td>
<td>1.4.1</td>
</tr>
<tr>
<td>PCI Interface Design Guide</td>
<td>Anybus-S Slave &amp; Master, Parallel Interface Design Guide</td>
<td>2.0</td>
</tr>
<tr>
<td><strong>X-gateway example</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Anybus X-gateway</td>
<td>Ethernet to PROFIBUS (Master), for example AB7800</td>
<td>N/A</td>
</tr>
<tr>
<td>X-gateway Manual Gateway Generic</td>
<td>Manual</td>
<td>1.11</td>
</tr>
<tr>
<td>X-gateway Manual Addendum EtherNet/IP Adapter/Slave</td>
<td>Addendum</td>
<td>1.05</td>
</tr>
<tr>
<td>X-gateway Manual Addendum Profibus Master</td>
<td>Addendum</td>
<td>1.10</td>
</tr>
<tr>
<td>Null modem cable (Supplied with the Anybus X-gateway)</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td><strong>Slave used in both examples</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Anybus Communicator for PROFIBUS</td>
<td>AB7000</td>
<td>N/A</td>
</tr>
<tr>
<td>Anybus Communicator Config Tool</td>
<td>Software</td>
<td>3.03</td>
</tr>
<tr>
<td>GSD-file for the Anybus Communicator</td>
<td>GSD-file</td>
<td>1.6</td>
</tr>
<tr>
<td>Anybus Communicator PROFIBUS User Manual</td>
<td>Manual</td>
<td>2.52</td>
</tr>
<tr>
<td>Configuration cable for the Anybus Communicator (supplied with the Anybus Communicator)</td>
<td>N/A</td>
<td>N/A</td>
</tr>
</tbody>
</table>

Note: The GSD files can be downloaded from www.anybus.com
More information about the network and the products

The latest manuals, the Anybus Communicator Config Tool, the Anybus NetTool for PROFIBUS, and the OPC Server for Anybus can be found on the HMS homepage, www.anybus.com.

The PROFIBUS user organization has a web site, www.profibus.org, where useful information about PROFIBUS can be found.
Solution overview

This application note describes how to configure the Anybus OPC-server using an Anybus product, the Anybus PCI-card or the Anybus X-gateway with an Ethernet slave interface.

Example 1 - Anybus PCI-Card

In this example a PCI PROFIBUS master and one slave node are used. Any bus type can be used, though. Please refer to www.anybus.com for available Anybus PCI-cards. An Anybus Communicator is used as a slave unit on the PROFIBUS network to loop the data back to the master unit. Other nodes may be attached to the network, but are not necessary to show the principles of configuration. In the following chapters, configuration is described step by step.
Example 2 - Anybus X-gateway

In this second example, an X-gateway with an Ethernet interface is used. As with the first example there are several options for which network/fieldbus to use, please refer to www.anybus.com for more information.
Anybus Configuration

The Anybus module has to be configured for the OPC server to go online. Also, the selected network, in this case PROFIBUS, has to be configured.

**Note:** The configuration of the Anybus Communicator is solely for test purposes.

PROFIBUS Master Configuration

Anybus NetTool for PROFIBUS is used to configure the PROFIBUS master and to set up the PROFIBUS network.

1. Start Anybus NetTool and start a new project.
2. Locate the ABM-DPV (PROFIBUS master module), Drag and drop it in the window to the right. The master module is configured as node 1.

3. Add the Anybus Communicator (Anybus Communicator - Slave):
   - Import the GSD file if the module is not included in the library by selecting *Install new GSD file* in the Tools menu.¹
   - Drag and drop to add the Anybus Communicator to the network
   - Set node number to the same value as is given by the configuration switches on the module, in this example 11.

---

¹ The GSD-file is available for download at www.anybus.com
4. Configuration of I/O data sizes for the slave.

**Note:** The I/O sizes depend on the application. The I/O sizes configured in this chapter are examples.

- Right click on the list (begins with *Slot*) below the PROFIBUS network, see Figure 2 on page 10.
- Select Module selection and choose 8 bytes for data in and for data out.
- If necessary change the offset address to 0 by right clicking on the Input or the Output address and select Properties. The start address can then be changed to 0.

![Figure 2 Slave I/O size](image)

5. Download the configuration to the Anybus-M PROFIBUS card, see manual for PROFIBUS master
Anybus Communicator Configuration

To verify the OPC-server configuration, a simple test hardware connection is set up. A dongle connects the Rx and Tx contacts at the serial port of an Anybus Communicator (PROFIBUS-DP Serial Gateway). The module will be configured in generic data mode, to loop back the data to the master.

1. Start the Anybus Communicator Config Tool
2. Set Fieldbus Type to PROFIBUS.DP

![Bus type setup](image)

Figure 3 Bus type setup

3. Set the module to Generic Data Mode

![Protocol mode configuration](image)

Figure 4 Protocol mode configuration
4. Configure the sub network
   - Message delimiter is increased to 10 ms (value = 1000)
   - The rest of the values are left at default.

5. Update time for produce transaction is set to 500 ms (value = 50)

6. Set length of I/O data to eight bytes.
Figure 7 Configuration of Consume (in) data (length and location)

7. Download the configuration to the Anybus Communicator (see manual)
X-gateway Configuration

An X-gateway or a PCI card can be used to verify the OPC configuration. If you use a X-gateway it will have to be configurated:

1. Start a HyperTerminal window on the PC
2. Connect a serial cable (null-modem) from the PC to the config port on the X-gateway.
3. Open the File menu, click on new, choose the desired COM port and click OK. The following window will appear:

![HyperTerminal Configuration](image)

*Figure 8 Configuring the connection in HyperTerminal*

4. Make sure that the settings are identical to those shown in the window above. An alternative method is to download the HyperTerminal session file from www.anybus.com, double click on it and select COM port. Connect and press ESC. The following menu will appear:

![X-gateway Main Menu](image)

*Figure 9 Anybus X-gateway main menu*
5. Press 6 and enter the desired configuration. The I/O sizes depend on the application.
In this case a PROFIBUS Master to EtherNet/IP X-gateway is used. The PROFIBUS
Master is configured for 8 bytes of I/O data and the EtherNet/IP for 0 bytes of I/O data.
This means that no bytes are available for the EtherNet/IP scanner on the Ethernet side
and 8 bytes are available for the OPC Server through the transport provider. For a more
detailed description see note below.

![Figure 10 The X-gateway configuration](image-url)
**Note**: The Transport Provider can use part of the Output Buffer to transfer I/O data. The amount of data allocated for the Transport Provider is defined as the difference in I/O sizes between the two network interfaces.

Example (not used in this test application):
I/O Size, Interface A = 8 bytes
I/O Size, Interface B (Ethernet Interface) = 2 bytes
Transport Provider I/O Size = (I/O Size, Interface A) - (I/O Size, Interface B) = 6 bytes

Figure 11 The I/O mapping for the X-gateway

The first byte to be used for the OPC Server in this example is byte 3. The first 2 bytes are used by the EtherNet/IP scanner for I/O data.

The mode above, called common access mode, is used when there is an EtherNet/IP scanner using the X-gateway at the same time as the OPC server. If the Ethernet transport provider and the OPC server shall handle all I/O data, all 8 bytes are channelled to the OPC server, and the I/O data size on the Ethernet interface should be set to 0 bytes.
OPC Server Configuration

There are three options (modes) when configuring the OPC server, depending on hardware and functionality.

<table>
<thead>
<tr>
<th>Mode</th>
<th>When to use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anybus X-gateway — Shared Access Mode</td>
<td>When you have an X-gateway connected through Ethernet to your computer, and also have other fieldbus communication running through the gateway. In this mode the EtherNet/IP scanner has access to one part of the output, and the OPC Server has access to the rest. The OPC Server can not write to the part controlled by the EtherNet/IP scanner, see “X-gateway configuration” in the previous chapter.</td>
</tr>
<tr>
<td>Anybus X-gateway — OPC Server Only Access Mode</td>
<td>When you handle all communication with the X-gateway from the OPC Server. The OPC Server has full access to the X-gateway and no EtherNet/IP scanner can be connected to the X-gateway.</td>
</tr>
<tr>
<td>PCI Card</td>
<td>When you have a PCI card installed in your computer</td>
</tr>
</tbody>
</table>

**Note:** The Anybus X-gateway — OPC Server Only Access Mode is hidden by default. It is enabled in the options dialog. see “Enabling OPC Server Only Access Mode” on page 26

**OPC Server Setup**

Most of the configuration is similar in the different modes. When the configuration differs this will be clearly stated.

1. Set up a new configuration:
   - Right click on the OPC Server icon in the Windows toolbar.
   - Choose *Open Configurator*

![Figure 1 Open the configuration](image)
2. Choose and configure data source
   - Choose data source type suitable to the mode you are using (see modes in table on page 17)
   - Choose device type, in this example PROFIBUS master
   - Name the server, e.g. to Profibus_M
   - Do not change I/O timeout for this example

![Anybus OPC Server Configurator](image)

**Figure 2 Choose and configure data source**
Transport Path ID Setup (determination of the link to the actual hardware)

1. Click on the browse button next to the Transport Path ID value field, and the following window will appear.

![Transport Paths window](image)

*Figure 3 Transport path configuration*

2. Click on Create and select the desired Transport Provider type. The Serial Transport Provider is not supported in this application. Depending on example setup choose either PCI Transport Provider (for PCI card) or Ethernet Transport Provider (for X-gateway).

![Please select a transport provider window](image)

*Figure 4 Select type of transport provider*
3. If PCI Transport Provider is chosen, enter a name when prompted. The following window will appear:

![Figure 5 Choose PCI hardware](image1)

4. If you have only one PCI card in your computer, press OK. If you have more than one, choose correct option from the list above and press OK. The name entered and a Path ID will be assigned to the path. Click on OK to accept the configuration.

5. If the Ethernet Transport Provider is selected, enter a name when prompted. The following window will appear:

![Figure 6 Choose Ethernet connection](image2)

6. Clicking on the button to the bottom right will start Anybus IPConfig. This tool can be used to configure the IP settings in the X-gateway by double clicking on the desired IP address.
7. Make sure that the Advanced tab has the settings shown in the figure below. Click OK when ready.

![Ethernet Configuration](image)

*Figure 7 Ethernet connection configuration*

8. Select the desired path in the Transport Paths window. Make sure the module is connected and configured for the same sub network as the PC used. As shown above, the tool Anybus IPConfig can be used to change the IP address of the X-gateway. The path will now be assigned the name entered by the user and a Path ID. In this case the path is available for all users, see the note below. Click OK to accept the configuration.

![Transport Paths](image)

*Figure 8 Accept the transport path*

**Note:** There are two types of paths, for the current user or for all users. A path for the current user can be accessed only by the user who configured the path, and the Path ID is numbered from 10000. A path for all users is available for all users and the Path ID is numbered from 1. If several users are using a computer it is strongly recommended to use a path for all users. To configure a path for all users, the user has to be logged in as a local administrator. When using Windows Vista also the OPC program has to be run in administrator mode.
Adding tags

The next step is to add the variables, the so called tags.

1. Select New Tag Group 1, right click at the first line on the right and choose Add New Tag.

2. To insert a new tag, configure the following parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Test setup description</th>
<th>Test setup value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the tag used in the OPC Server.</td>
<td>The tags are named “Input Byte X” and “Output Byte X”, where Input contain values coming to the OPC server and Output contain values going to the fieldbus. X denotes the number of the variable.</td>
<td><em>[Input Byte X, Output Byte X]</em> X = 0 .... 7</td>
</tr>
<tr>
<td>Data source</td>
<td>Data source (hardware) the Tag refers to. Click the cell to get a drop down box with the existing data sources.</td>
<td>The data source(s) has been named earlier during the configuration</td>
<td>Profibus_M</td>
</tr>
<tr>
<td>Address</td>
<td>Address within the Data source to which the Tag refers. Click the ellipsis button to display the Item Address Mapping dialog, see below.</td>
<td>8 bytes in each direction are used for the test setup</td>
<td>IB000 - IB007, QB000 - QB007</td>
</tr>
<tr>
<td>Data type</td>
<td>Coerce the value of the OPC Item to the specified type unless Default is selected. Also serves as the data type for the Tag.</td>
<td>Default is used for the test setup which will make the data type used the same data type as configured for the address. In this case byte</td>
<td>Default</td>
</tr>
<tr>
<td>R/W</td>
<td>Sets the access rights for the tag. Click the cell to get a drop down box.</td>
<td>The input tags are defined as R. The output tags are defined as RW for the test setup.</td>
<td>R/RW</td>
</tr>
<tr>
<td>Scaling</td>
<td>Displays information about if scaling is active for the Tag or not. Click the ellipsis button to display the Scaling dialog.</td>
<td>No scaling is used for the test setup</td>
<td>Off</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
<td>Test setup description</td>
<td>Test setup value</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Offline Option</td>
<td>Defines the action that will be taken for the tag if connection to the data source is lost. Click the cell to get a drop down box with the Offline Actions possibilities: Continue - Tag value freezes when data source connection is lost and continues as soon as the connection is up again Clear to Zero - Tag value is cleared to zero when the data source is lost and will stay cleared even after reconnection of the data source. Freeze - Tag value freezes when the data source is lost and will stay so, when the data source is reconnected.</td>
<td>In this test, the built-in monitor is used. You can choose any offline option available, but the OPC server will always go to “Continue”. When running an external client, any option can be used.</td>
<td>Continue</td>
</tr>
<tr>
<td>Value</td>
<td>Displays the Tag value when monitoring is enabled.</td>
<td>Does not have to be configured. Only used for monitoring purposes.</td>
<td>Value monitored</td>
</tr>
<tr>
<td>Quality</td>
<td>Displays the Tag status when monitoring is enabled.</td>
<td>Does not have to be configured. Only used for monitoring purposes.</td>
<td>Quality of the connection</td>
</tr>
</tbody>
</table>
3. Configure the address.
   - Select the data direction for the variable, “Data from Network” for the input variables and “Data to Network” for the output variables.
   - The data type defines the data type for the variable
   - Indicate the offset by clicking on the correct Offset value (in this case 0)

![Figure 10 Configuring the address](image)

When the setup is complete, the configuration should indicate the following:

![Figure 11 The list of tags used in this example (X-gateway - shared access)](image)
**Going On Line**  
The final step is to make the server go on line.  
1. Click on the server configuration, Profibus_M in this case.  
2. Mark the check box *Enabled*  
3. Click on *Apply*
Enabling OPC Server Only Access Mode

Only the parts of the setup that differ from the setup for X-gateway, Shared Access Mode, are described here.

Enable OPC Server Only Access Mode

To use this mode, you first have to enable the mode in the Options menu. Choose **Edit -> Options**

![Options](image)

*Figure 13 Enable Anybus X-gateway OPC Only Access Mode*

Ensure that the check-box is marked.
Testing the configuration

To test that the OPC Server is working properly, the monitoring function of the OPC Server is used.

Click on **Server Namespace** and Choose **New Tag Group 1**.

![Figure 1 Startup Tag Screen](image_url)

Press the **Monitor** button at the top of the window.

If the configuration has been performed correctly you should be able to see that the Quality of the connection is “GOOD” and that the value 0 is displayed for both Input and Output variables. To write a data value to the node, right click on the Output value and choose **Write value**. Enter 1, 2, 3, 4 on the first four Output bytes and the value should change according to the picture above. Since you have a loopback plug on the ABC you should shortly after get the data value looped back to the Input variable.

Saving the configuration

To save the configuration, click on **File** and choose **Save As...** in the menu. Enter **Place** and **Name** when prompted, and click on **Save**.